Pearson Voluntary Product Accessibility Template (VPAT)

Accessibility Documentation

A Voluntary Product Accessibility Template (VPAT) is used to assist Federal contracting officials, agencies and buyers in making preliminary assessments regarding the availability of accessibility support in products like MyMathLab. A VPAT for MyMathLab is available upon request by emailing disability.support@pearson.com.

Accessibility Information

- **General Information** (Links to an external site.)
- **Using a Screenreader** (Links to an external site.)
- **Screen Resolution** (Links to an external site.)
- **Using the Browser Zoom Function** (Links to an external site.)
- **Using Magnification Tools** (Links to an external site.)
- **Specifying Contrast Settings** (Links to an external site.)
- **Closed Captioning** (Links to an external site.)
- **Navigating with a Keyboard** (Links to an external site.)
- **Obtaining Math Textbooks in an Accessible Format** (Links to an external site.)
- **Accessibility Documentation** (Links to an external site.)

Pearson works continuously to ensure our products are as accessible as possible to all students. The platform team for MyMathLab and its related products — MyStatLab, MathXL, and MyMathTest — is working toward achieving WCAG 2.0 Level AA and Section 508 standards, as expressed in the Pearson Guidelines for Accessible Educational Web Media (Links to an external site.).

Moreover, our products support customers in meeting their obligation to comply with the Americans with Disabilities Act (ADA) by providing access to learning technology programs for users with disabilities.

The following information provides tips and answers to frequently asked questions for those using assistive technologies to access the MyMathLab suite of products. As product accessibility evolves continuously, please email our Accessibility Team at disability.support@pearson.com for the most up-to-date information.

**Using a screenreader**

Users with low, or no, vision can use screen-reader software for the html portions of the site. Screen readers such as JAWS and Window-Eyes can read the Calendar, Results, Announcements, Study Plan topics, and list of available assignments to you.

The questions in assignments (homework, quizzes, and tests), as well as those in the Study Plan, are rendered using Adobe Flash. MyMathLab supports access to selected single and multiple answer multiple-choice and free response questions with the JAWS screen reader (v. 12, 13, 14). For free response questions, a text equivalent of math notation and symbols (command line language) can be entered using the keyboard. For help on getting started, use the Quick Start Instructions for Using.
MyMathLab with JAWS 12, 13, and 14 (.doc) (Links to an external site.). Additional information is available in the student online help.

Enhancements to the assignment manager now allow instructors to easily identify and select accessible questions. For textbooks with copyright 2012 and later, screen reader accessible questions have a "blue ear" icon next to them and include the alternative text description, "Question is screen reader accessible." On special request, identification of accessible questions in older textbooks can also be provided.

While you are using the JAWS screenreader, you may have questions that do not work correctly. Below is a list of some of the known issues that we are working to resolve.

In some questions, the decimal number is read incorrectly.

In some questions, expressions are not read in one line.

**Screen Resolution**

You may find that lowering your screen resolution will magnify the HTML site pages and help you see text and images more easily. As a start, try a resolution of 600 x 800 (in Windows) and see how that works for you.

**operating system** | **How to change your screen resolution**
--- | ---
Windows | · From the Start menu, go to the Control Panel
| | · Select "Display"
| | · On Windows XP, select the "Settings" tab and select the resolution.
| | · On Windows 7, select the option "Change Display Settings" and select the resolution.
| | · From the Apple menu, select "System Preferences"
Mac | · Select "Display" from the Hardware section
| | · Select the resolution from the Display view

**Using the Browser Zoom Function**

While you are working, you may want to magnify certain areas of the site. Use the zoom-in hotkeys available in most browsers.

**Note:** To magnify the question in the Flash player, please refer to the section on Using Magnification Tools below.

**operating system** | **How to change your screen resolution**
--- | ---
Windows | · Press the "CTRL" + "+" keys at the same time to magnify
Operating System

How to change your screen resolution

- Keep pressing the "+" keys to continue magnifying
- Use the "CTRL" + "-" keys to undo the magnification

Mac
- Press the Apple Command button + "+" keys to magnify
- Press Apple Command + "-" keys to undo the magnification

Using Magnification Tools

Users who have low-vision and need to magnify the page may find that using magnification programs works better for them as there are more options for magnification strength and other display settings.

<table>
<thead>
<tr>
<th>Magnification Tool</th>
<th>Tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZoomText</td>
<td>For some computer configurations, the XFont setting needs to be turned off. If so, select None or Standard for your Font Enhancements setting. In ZoomText 10: 1. Select &quot;Magnifier&quot; from the main menu 2. Select Font Enhancements from the Magnifier menu 3. Select Settings and then for Enhancement Type, choose None or Standard</td>
</tr>
<tr>
<td>Microsoft Magnifier</td>
<td>Magnifier is a tool that comes with the Windows Operating Systems. You can magnify and apply color contrast to your page using this tool. A known limitation with Magnifier is that you cannot interact with the page using the Magnifier window.</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Use the Control button + mouse scrollbar to control the level of magnification. Magnification is available with several computer mice including: · Microsoft Comfort Optical Mouse · Microsoft Optical Mouse 3000 By using a button on the mouse, magnification can be turned on and off. The magnification level and size of the magnification window can be selected. For some computer configurations, the TrueFonts setting needs to be turned off. If so, select None for your Font Smoothing setting.</td>
</tr>
<tr>
<td>SuperNova</td>
<td>In SuperNova 13: 1. Select &quot;Visual&quot; from the main menu</td>
</tr>
</tbody>
</table>
2. Select "Advanced Options" from the Visual menu
3. Select "Magnifier" and then for Font Smoothing, choose "None"

Specifying Contrast Settings

Some users need higher or a different color contrast to see content on pages. For example, you may find it easier to see light text on a dark background, dark text on a light background, or in grayscale.

How to change your contrast scheme

Choose from several color and contrast schemes using the software product ZoomText.

1. Select "Color" from the menu
2. For lighter color text on a dark background select Invert Brightness.
3. Or try different schemes until you find the one that helps you most.

Choose a contrast scheme from the operating system's display settings.

1. From your Control Panel select "Accessibility Options."
2. From the Display tab turn on Use High Contrast.
3. Go to Settings and select the contrast scheme. For black text on a light background, use High Contrast Black. For white text on a dark background, use High Contrast White. Or try different contrast schemes until you find the one that helps you most.

Note that this tool is limited and it will not apply the color scheme to the Player.

Choose a contrast scheme from the operating system's display settings.

1. From the Control Panel select "Ease of Access Center."
2. Select "Set up High Contrast."
3. Select "Choose a High Contrast Theme." For black text on a light background, use High Contrast Black. For white text on a dark background, use High Contrast White. Or try different contrast schemes until you find the one that helps you most.

Note that this tool is limited and it will not apply the color scheme to the Player.
Operating system  How to change your contrast scheme

Choose a contrast scheme from the operating system's display settings.

1. From the Apple menu select "System Preferences"
2. From System Preferences select "Universal Access"
3. Select the "Seeing" tab
4. For black text on a light background select "Black on White" from the Display options. For white text on a dark background select "White on Black" from the Display options. Or try the Enhance contrast option for other contrast schemes.

Note that this tool is limited and it will not apply the color scheme to the Player.

If you find seeing in grayscale more helpful, you can change the display setting on your Mac operating system to grayscale. In Windows, you will have to use additional software to see the site pages in grayscale.

Operating system  How to see in grayscale

Contrast-Analyzer

1. Download the free software from the Paciello Group at: http://www.paciellogroup.com/resources/contrast-analyser.html (Links to an external site.)
2. Go to the Image menu and then select the "Screen" item
3. From the Simulation pulldown, select "grayscale"
4. To see the entire window in grayscale use the "Select Window(List)" item from the Image menu

A limitation with this software is that you cannot interact with the page in the grayscale view.

Note: For higher contrast try the invert display option.

Vision Australia Browser Toolbar for Internet Explorer

1. Download the free software from Vision Australia http://www.visionaustralia.org.au/ais/toolbar/ (Links to an external site.)
2. Open your browser, go to the site page and select "grayscale" from the Color option

A limitation with this software is you need to perform this action for each page you visit.
Operating system

How to see in grayscale

1. From the Apple menu select "System Preferences"

2. From System Preferences select "Universal Access"

3. Select the "Seeing" tab

4. Select "Use grayscale" from the Display options

Closed Captioning

For hearing-impaired students, closed-captioned videos are available in nearly all courses accompanying textbooks with a copyright year of 2010 or later. On special request, these closed-captioned videos can also be provided on CDs.

Navigating with a Keyboard

If you have difficulty using your mouse because of motility impairment, you may find using your keyboard easier. Low-vision users may also find using the keyboard easier as it may be difficult to see the mouse pointer and its location on the screen.

You can use the Tab key to visit all links, buttons, and form controls.

You can interact with form controls using keystrokes on your keyboard. For example, use the Tab key to navigate to an edit field on a site page and then use the alphanumeric keys to enter in your information. Once you have completed entering in your information, use the TAB key to leave the control.

You can use keyboard shortcuts for the math palette tools when working on questions. The keyboard shortcuts are provided in the online help.

Obtaining Math Textbooks in an Accessible Format

Many of our leading math textbooks are now offered as HTML eBooks for students using assistive technology to access course materials. Compatible with JAWS and other Windows screen readers, HTML eBooks are national mathematics texts published in HTML and MathML to offer students the following:

- complete core content, including text and images, in single column presentation.
- alternative text descriptions for all important figures and photos.
- enhanced navigation support, including interactive table of contents, go-to-page functionality, and keyboard access.

HTML eBooks are provided on the MML site so that all students can access needed texts at the same place, at the same time, and at the same price. Students with a Windows screen reader need only to download the free Design Science MathPlayer (Links to an external site.).
To learn more about HTML eBooks, contact your Pearson representative (Links to an external site.) or email mymathlab@pearson.com (Links to an external site.).

For texts and related materials not in the HTML eBook format, Pearson can provide PDFs of your textbook or eText, Student Solutions Manuals, Graphing Calculator Manuals, and other ancillaries, which can be converted and then be used with accessibility technologies as screen readers and Braille displays. You can also convert the PDF files into another format, such as a printed Braille book. You can make requests for the PDF files at https://order.superlibrary.com/Comergent/en/US/adirect/pearson?cmd=DisabilityRequestForm (Links to an external site.)

Please direct general inquiries to alternate.textbooks@pearson.com.

You can view the list of books available in HTML eBook format by selecting this option under "Course Features" on the left side of the Titles Available page (Links to an external site.).

**Accessibility Documentation**

A Voluntary Product Accessibility Template (VPAT) is used to assist Federal contracting officials, agencies and buyers in making preliminary assessments regarding the availability of accessibility support in products like MyMathLab. A VPAT for MyMathLab is available upon request by emailing disability.support@pearson.com.